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 Unit One : Web sites 

The First Topic : Concepts and the basics of Web sites 

1- Complete :-  

1- A Website is a webpage or more, connected with each other, with a certain 

name and Web address. The website can be visited on the computer or the 

cell phone. 

2- Static Web Pages and interactive web pages  are types of web pages. 

3- A static web page :The content of these pages is previously prepared by 
the page developer. The content doesn’t change and can’t be edited by the 
visitor. It is designed by HTML code I designing such pages.  
4- Interactive Web Pages is a webpage that has a content allowing the visitors 
to interact with and manipulate. This type is designed by HTML , JavaScript, 
PHP and others. 
5- The elements of the web Pages are texts, images, videos and hyperlinks. 

2- Write the scientific terms of the following: 

1- It is a document with electronic content on the internet which can be 
shown through a web browser.      (Web page) 

2- It is the opening page in the website through which other pages can 

be visited.           ( Home page of web site)                                                                                                                                                                     

 

Unit One : Web sites 

The Second Topic  

Stages of designing and creating a website  

1- Complete :-   

1- The stages of designing and creating a website are :- 

 a- The first stage : Planning to create a website. 

 b- The second stage : Design the web pages. 

 c- The third stage : Prepare and develop the web pages. 

 d- The fourth stage : Implement the web pages.  

 e- The fifth stage : Publish the website on the internet. 
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2- Write the scientific terms of the following: 

1- we draw a simple diagram of the web pages of the website, the homepage 

and the connected pages - Decide the information and data to be included as 

data or service according to the need..  

    (Planning to create a website) 

2- This stage is the most important one as we design the format and shape of 

the homepage and other pages. The different format types are designed, the 

colour, the background, the font size and type, place of putting text, images 

and video clips and decide the different hyperlinks inside the same page and 

connected with other pages in the website.      

(Design the web pages) 

3- This stage consists of important steps which are as follows:-  

Prepare the text which will be added to the page using a text editor 

program and save it in a folder. 

-Prepare the image files and save them in a folder. 

-Prepare the video and sound files and save them in a folder. 

              (Prepare and develop the web pages) 

4- This is the stage when we change the paper design into web page to be 

shown and visited on the internet with an internet browser program. 

- Input the data, text, images, And videos and so on. 

- Create the necessary hyperlinks to connect the different pages and 

facilitate browsing the site. This is done using HTML codes.    

(Implement the web pages) 

5- In this stage, a web address is taken and the storage capacity is decided 

to save on one of the servers and publish the site on the internet.   

                (Publish the website on the internet) 

 

 

 

 

 

 

 



Computer and Information Technology  

Second Prep                                                    4                                                           First Term 2021/2022  

The Third Topic : Create and Edit Audio Files  

 in Audacity Program  

1- Complete :-   

1- To start voice recording through the Audacity program, click the Record 

button where the program becomes in the audio recording mode. 

2- To complete entering audio data or to finish recording , click "Stop" button 

in the program. 

3- To listen to the sound that has been entering click "Play" button in the 

program. 

4- When we choose “Repeat “ effect, the selected clip is repeated. 

5- On choosing "Reverse" effect, the beginning of audio is reversed with the 

of the end section. 
 

2- What are the steps to add an effect on the audio clip:- 

(1) Audio playback by clicking " Play button" and listen to it. 

(2) Select the desired audio clip added to effect it by clicking and dragging on 

the desired sound indicator reading at the time the timeline. 

(3) From " effect" menu, select one of the desired changes. 

(4) Rerun the audio by clicking "play" button and listen to the audio clip after 

adding the effect. 

3- What are the steps to Cut and paste an audio clip:- 

(1) Select the audio clip you want to cut, From "Edit" menu select " Cut". 

(2) Move the pointer on the timeline to the desired place to paste the 

audio clip, From the "Edit" menu select" Paste". 

(3) Rerun the audio by clicking the play button and listen to it. 

4- What are the steps to delete a section of the audio:- 

(1) Select the audio section you want to delete. 
(2) Press " Delete" from the keyboard to delete the audio section you selected 

5- What are the steps to export an audio file with an  

appropriate extension:- 

(1) From the "File" menu, select "Export Audio" 
(2) Select the appropriate extension of the audio file. 
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6- Compare between the file with WAV extension and Audio 

MP3 file:- 

The file with WAV extension The file with MP3 extension 
- It is characterized by the sound 
quality and clarity. 

- The sound is of less purity, 
compared with the file with WAV extension. 

- It has a large storage capacity, so it 
is not appropriate for publication 
via websites. 

- It has less storage capacity, 
so it is appropriate for publication via 
websites. 

The Fourth Topic : Creating and Editing Video Files 

In Openshot Program 

1- Complete :-   

1- Creating and editing video programs are the ones that enable the user 
to create and edit video files. This is done through tools and effects that 
help the user create and edit video clips easily and fast. 
2- There are many programs that can be used in creating and editing video 
files like: “OpenShot”, which are open source and free to use and easy to 
operate with Linux and Ms. Windows. There is also “Movie Maker” which 
runs in Windows.  
3- The interface of Openshot consists of 

1- Main Toolbar. 
    2- Project Files. 
   3- Function Tab (Move –Images 
                                  -Audio files) 
    4- Preview Window. 
    5- Edit Toolbar. 
    6- Zoom Slider. 
    7- Play head/Ruler. 
    8- Timeline. 
4- Program Timeline is consists of : 

a- Ruler (to show the time length on the timeline). 
b- Play Head (reads the current clip on the timeline to show in Preview 

Window). 
c- Current Clip (image, sound or video). 
d- Tracks (They are similar to Layers where images, sounds or video caption 

clip is put on the track. Unlimited number of tracks can be used in the 
project. Notice that the higher track has the priority to read to show the 
video, then the lower and so on.) 
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5- To add a new Track, click the +Add Track icon on the Edit Toolbar. 

2- What are the steps to create a video clip :- 

   1-Import image files into the OpenShot program (Click Import files icon  
       + in the Main Toolbar to add the images.( You can import files from  
       File, then Import Files).  
   2- Put Images in order on the Timeline (Drag and drop the images in  
        the “Project Files” window and put all the images in Track path and  
        put them in the suitable order then they become a (Video Clip) and    
        appear in the Video Preview). 
   3- Import Sound files into the program (To add sound file, click Add File  
        icon + on the Main Toolbar and add the sound file to appear in  
        “Project Files” tab then drag and drop the sound sign to insert in one  
         track). 
   4- Preview the video (To preview the video, click the Play icon in the  
        Preview window).  
3- What are the steps to save Project in OpenShot program:- 

(1)  Save all the used files,( images, sound, text…) in a specific folder. 
(2) From the Main Toolbar, select File then select  Save Project As. 
(3) Name the project in English. 

3- Important Notes for you to save the project: 

During work in OpenShot in Ms Windows, and saving the project, you may notice 
that the file is unknown so it appears. 
To make the file work in the OpenShot program: 

-   Right click on the file . 
    - Select "Properties" and select "change" then select "more options". 

-   Select : "Look for another app on this PC ."  
-   The system will find the OpenShot application folder. 

    -Select association to the executable file of the program 

4- What are the steps to control the play time of the Video Clip:- 

(1) Drag and drop the head of the play indicator and move it till it goes to the right 
place on the timeline. 
(2) Right click the clip Track, a drop box appears. 
(3) Select "Slice Clip" to split the clip into two slides, The following appears:- 

"-    Keep Both Slides", the right and left slides are kept. 
-    "Keep the left slide", The clip splits into two slides and keep the left  

        slide only. 
     -"Keep the right slide", The clip splits into two slides and keep the   
        right slide only.  
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5- What are the steps to add Effects to a Video Clip:- 

(1) Click the Effects tab. 
(2) Drag and Drop an effect to add it to the clip. 
(3) The effect sign appears on the clip. 
(4)To read the effect name put the cursor on the effect sign. 
(5) To delete the effect, right click the effect sign and select “Remove Effect”.  

6- What are the steps to add Transitions to a Video Clip:- 

(1) Click the Transitions tab. 
(2) Drag and drop one transition and add it to the clip. 
(3) Add a transition at the beginning and at the end of the clip. 
(4) Clip the transition time length by drag and drop it to increase or decrease it.  

7- What are the steps to add text to a Video clip:- 

(1) From "Title" menu, select "Title". 
(2) Fill in the dialog box. 
(3) Save text in a file “Save.” 
(4)Name the text file in English. 
(5) The text file is found in “Project Files.” 
(6) Add text file to the video clips by drag and drop the text file and add it to a 
track. 

 

 

8- What are the steps to export a video to a file with suitable 

extension:- 

(1) Press "Export Video" 
(2) In the Dialog box of “Export Video", select the following: 

-     File Name. 
-     Folder Path. 
-     Extension of the Target video File. 
-     Decide the Quality level. 

      -Export the video by pressing “Export Video” 

9- Put (√) or (×):- 

1- To change the order of the video clips (images/ sound) on the track in 
OpenShot program , drag and drop and reorder them.   (√) 
2- To set playing the sound file in OpenShot program , drag and drop the 
sound on the track on the Timeline and put in its place.                       (√) 
3- In OpenShot program the text can be added at the beginning, in the middle 
or at the end of the video clip.         (√) 
4- You can reorder the video clip ( audio , images or text ) on the Track.(√)  



Computer and Information Technology  

Second Prep                                                    8                                                           First Term 2021/2022  

Unit (2)    Creating Web Pages by using HTML 

Lesson (1)     HTML 

1- Complete:- 

1- HTML is a coding language used to create internet pages which are used 
through an internet browser. 
2- To create a web page, HTML codes are used, these codes are called Tags, 
an internet browser executes these tags on the browser page. 
3- You must write the HTML tags between these signs “< >”. 
4-You must save the text file with the HTML tags with .htm or .html extension 
5- You must type <html> at the beginning of the tags to refer that the 
document is written in .html. 
6- The HTML tag is divided into two parts : Head and Body. 
7- Head is the part where the page information is typed for the browser While 
body is the part where the content is written .  
8- The web page consists of a TITLE and CONTENT, the title appears in the 
address bar at the top of the page. 
9- The web page can include text, image, video and hyperlinks. 
10- To add a text inside the content of the web page : write the text inside the 
<body>…</body> tag.  
11- You can write the HTML tags with Capital letters or Small letters. 

in the file the left spacesThe internet explorer isn't affected by   -12 
or by moving to a new line by pressing the enter key. 
13- When designing a web page with Arabic view, we have to change the 
direction of the page to make the content from right to left to suit the Arabic 
language and to execute this, we use the property "dir", where we specify the 
direction of the web page according to the value of the property dir . 

While  from right to left the direction" to change rtlWe use the property " -14
.rightto  leftfrom  the direction" to change ltrwe use the property " 

15- To change the direction <body> to be from right to left, we write   
<body dir="rtl"> . 
16- We use <br> tag to start writing in a new line. 
17- To put a text in the middle of the line, we use <center>  text  </center> 
tag .  
18- To add blank space between words we use  &nbsp; and we repeat it 
according to the number of the needed spaces between words. 
19- To control the face, the size and the color of the font, the font is 
formatted by the <font> text </font>  tag . 
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20- After using the close </font>, this finishes the effect of the tag on any 
text written later and after that the text displays with the default shape. 
21- When we don't use the <font> tag ,the color face displays on the web 
page with the default face. 
22- To make the text underline, we write <u> text </u> tag. 
23- To make the text bold, we write <B> text </B> tag. 
24- To format the font of the text "School" to be italic, we write the code: 
<I> text </I> tag. 
25- To format the font of the text "School" to be bold, we write the code: 
 <b> School</b>.  

26- To format the font of the text "School" to be underline, we write the code: 
 <u> School</u>.  
27- We use the property bgcolor that connects to the <body> tag to select the 
color of the web page background. 
28- To make the background of web page green we write the code:  
<body bgcolor="green"> 
29- To add an image as a web page background, we use the property 
Background that relates to the <body> tag . 
30- To add image "image1.jpg"as a web page background, we write the code : 
<body background="image1.jpg" >. 
31- To insert image in the web page, we use the property src to <img> tag. 
32- To insert image "school.jpg" in the web page, we write the code:  
<img src="school.jpg">. 
33-  To insert the image " school.jpg" in the web page and make its 
dimensions as follows: Width= 800 pixel and Height= 450 pixel, we write the 
code: <img src="school.jpg" height="450" width="800">. 
34- We align the image through the property Align to the <img> tag. 
35- To align the image " school.jpg"  to the right, we write the code: 
<img src="school.jpg" align="right">. 

36- To align the image " school.jpg" to the left, we write the code : 
<img src="school.jpg" align="left">. 

37- To center the text in the middle of the image  " school.jpg" , we write the 
code : <img src="school.jpg" align="middle">. 
38-  To make the text is positioned align down the image " school.jpg" , we 
write the code : <img src="school.jpg" align="bottom">. 

39- To make the text is positioned align top the image "school.jpg", we write 
the code : <img src="school.jpg" align="top">. 
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40- To insert the sound as a background to the web page, we use the property 
src that follows <bgsound> tag. 
41- To insert the sound file " Egypt.mp3" as a background to the web page , 
we write the code : <bgsound src="Egypt.mp3">. 

42- To insert the video inside the web page, we use the property src that 
follows < embed> tag we must notice that the tag supports the video file of 
the type (.swf - .avi - .mov). 
43- To insert the video file "internet.avi" inside the web page, we write the 
code : <embed src="internet.avi">. 
44- Hyperlink is a hyper image or a hypertext, connected to a title and 
when we click it, we move to this title and it can be in the same page or 
in another one, in the same site or in another one. 
45- To insert a hyperlink, we use href property to the <a> tag that selects its 
value; the needed title, that we want to move to, as follows 
 <a href= "the needed title, we want to move to" > the text or image </a>. 
46-To create a web page that contains a hyperlink text "Ministry of Education" 
When we click on it, it moves to the main homepage of the Ministry, we write 
the code : <a href="http://www.moe.gov.eg" >Ministry of Education</a>   
47- To create a web page that contains a hyper image " tools.jpg" and when 
we click the image, we move to the web page "My school", we write the code: 
<a href ="myschool.htm"><img src="tools.jpg"></a>. 
48- To choose the font, we use the property <face> that follows <font> tag  
while to choose the font color, we use the property <color> that follows 
<font> tag  and to choose the font size, we use the property <size> that 
follows <font> tag  .  
49- To make the text "مدرستى جميلة" with Andalus face, red color and size 6, we 

write the code :  

</font>    مدرستى جميلة    <font face="andalus" color="red" size="6"> 

50- To add the text " مدرستي " as a title to the web page we write the code:  
<title> مدرستي</title>  

.><head >...</headtype the tag <title> …. </title> in the field  We -51 

52- To change the font size, we have to notice that the browser identifies 

" the value is sizechoose by the property "seven different font sizes that we 

from 1 to 7. 

." to measure the image dimensionspixelWe use the measurement unit " -53 

54- HTML refers to the phrase Hyper Text Markup Language. 
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55- The web page which uses HTML in its design, it is only considered a static 

page. 

56- Using languages like JavaScript and PHP besides HTML in the design of 

the web page is to modify the page to interactive. 

57- To display a text on the web page, we write the text in the Body. 

2- What are the Structure of a web page created by HTML? 

 
 

 
  
 
 
 
 

3- Match:- 

A B 

1- Web Site (3 ) a document with e-content that is published on the 
internet and is displayed by the browser. 

2- Homepage ( 4) display read-only information without the ability to do 
processing from guests to the content 

3- Web Page (1 ) a place on the internet that is consisted of a web page or 
more and is visited through specific titles 

4- Static Page ( 2) the first page on the web site and through it we easily 
move to the rest pages. 

5- Dynamic / 
Interactive 
page 

(- ) the property to move to the site pages. 

 (5 ) information page that displays an interactive content to 
the guests to interact and process it. 

4- What are the steps to create a web page with the name 

school.htm and add the text  "مدرستي " as a title to the web 

page? 

1- Upload a text editor program Ms word or Notepad. 

2-Write the Structure of a web page created by HTML.  

3- Type the tag <title>  مدرستي</title> in the field <head >...</head>. 
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4- Save the file with the name school.htm 

5- Open the file school.htm (the web page) using a web browser to see the 

result of executing the typed tags. 

5- Put (√) or the correct sentence and ( X ) for the wrong one: 

1-HTML is used to create interactive web pages.     (×) 
2- JavaScript is used to modify the static page to interactive page.  (√) 
3- The tag that is written at the beginning of the code to refer that the 
document is written by html is <title>.       (×) 
4- To control the number of the spaces between words, we use the symbol 
&nbsp;.            (√) 
5- To add image to the web page, we use the <img> tag.   (√) 
6- <img src= "school.png"> 
Although there are no errors in the previous code, the image doesn't display 
on the web page when loading it by the browser. Give a reason? 

The answer:- 

The image file and the web page file aren’t in the same folder and The image 
file and the web page file must be in the same folder, so we write the image 
file name and its extension with the property src. 
 -In case, there is a file image in another folder, we must write the complete 
path of the image file. 

 

7- Explain what is meant by the following codes: 

1- <Title> My School </Title> 
To add the text " My school " as a title to the web page . 

 

 
2- <body bgcolor="green"> 
To make the background of web page green . 
 

3- <Img src = "school.png"> 
To insert image " school.png " in the web page . 
 
4- <font face="andalus"> 
To make the text with Andalus face . 
 
5- <bgsound src="egypt.MP3"> 
To insert the sound “egypt.MP3”as a background to the web page. 
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Practical Questions 

1- Open Audacity program then :- 

a- Insert a suitable audio file. 

 b- Add "Repeat" and "reverse" effect. 

 c- Export the audio file with ".Wav" extension on the desktop and  

              name it "sound". 

 

The answer 

 a- To insert a suitable audio file : From file menu select open. 

b- To add "Repeat"  effect : from "effect" menu select "repeat", To add 

"reverse" effect : from "effect" menu select "reverse". 

c- To export the audio file" : From the "File" menu, select "Export Audio" 

and select the extension ".wav" on desktop and name it "sound". 
 

 

2-  Open Audacity program then :- 

a- Insert a suitable audio file. 

 b- Delete  a section of the audio file. 

 c- Export the audio file with ".Wav" extension on the desktop and  

              name it "prep2". 

 

The answer 

a- To insert a suitable audio file : From file menu select open. 

b- To delete  a section of the audio file : Select the audio section you want to 

delete then  press "delete" key from keyboard. 

c- To export the audio file" : From the "File" menu, select "Export Audio" 

and select the extension ".wav" on desktop and name it "prep2". 
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3- Open Openshot program then :- 

a- Import images and sound file to the program. 
 b- Put the images and sound file in order on the program timeline. 
 c- Add transitions to the video clip. 
 d- Export the video file with ".mp4" extension on the desktop and  
              name it "school".  

The answer 
a- To Import images and sound file to the program: From "file" menu select 
"Import files". 
b- Drag and drop the images and sound file in the “Project Files” window 
-Put all the images and sound in Track path and put them in the suitable 
order. 
c- To add transitions: click on "transitions" tab, drag and drop one of the 
transitions to add to the video clip. 
d- To export the video file  : From the "File" menu, select "Export video" 
and select the extension ".mp4" on desktop and name it "school". 
 

4- Open Openshot program then :- 

a- Import images and sound file to the program. 
 b- Put the images and sound file in order on the program timeline. 
 c- Add effects to the video clip. 
 d- Add the text " prep2"  to a video clip. 

e- Export the video file with ".mp4" extension on the desktop and  
              name it "salam".  

The answer 
a- To Import images and sound file to the program: From "file" menu select 
"Import files". 
b- Drag and drop the images and sound file in the “Project Files” window 
-Put all the images and sound in Track path and put them in the suitable 
order. 
c- To add effects: click on "effects" tab, drag and drop one of the effects to 
add to the video clip. 
d- To add text: from "Title" menu select "title", fill in the dialog box and save 
text in file "save" , name the text file in English, the text file is found in 
"project files", add text file to the video clips by drag and drop the text file and 
add it to a track. 
e- To export the video file : From the "File" menu, select "Export video" 
and select the extension ".mp4" on desktop and name it "salam". 
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5- Open Notepad program then:- 

a- Add the text "School " as a title to the web page. 
b- Change the direction of the content of the web page to be from right  
     to left. 
c- Add the text " السلام الاعدادية الثانوية مدرسة "  to the content of the  
     web page in the middle of the line and make the text bold, italic and  
      underline. 
d- Change the background color to be "Yellow". 
e- Save the text file on desktop and name it "Computer". 
Open this file in any web browser. 

The answer 
<html>                                                                                                        
<head> 

<title> School </title> 

</head> 

<body  dir="rtl" bgcolor="yellow"> 

<center> <B><I><u>  مدرسه السلام الأعداديه الثانويه  </B></I></u></center> 

</body> 

</html> 
 

File->save  computer .html 

6- Open Notepad program then:- 

a- Add the text "School " as a title to the web page. 
b- Add the text "مدرستى جميلة"  to the content of the web page and    
add  four blank space between the word "مدرستى" and the word     
 ."جميلة"
c- Add an image from your computer as a web page background. 
d- In a new line create a web page that contains a hyperlink text   
  When we click on it, it moves to the main ,"وزارة التربية والتعليم"
 homepage of the web site "www.moe.gov.eg". 
e- Save the text file on desktop and name it "Computer". 
Open this file in any web browser. 

The answer 
<html>                                                                                                                                                                                                            

<head> 

<title> School </title> 

</head> 

<body  background="image.jpg" > 

<center>  جميلة &nbsp; &nbsp; &nbsp; &nbsp;  مدرستى</center> 
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<br>   <a href="http://www.moe.gov.eg"> والتعليم التربية وزارة   </a> 

</body> 

</html> 

File->save  computer .html 

 

7- Open Notepad program then:- 

a- Add the text "School " as a title to the web page. 
b- Change the direction of the content of the web page to be from right  
     to left. 
c- Add the text "مدرسة السلام الاعدادية الثانوية المشتركة"  to the content of  
the web page, then in new line add the text " مدرستى جميلة ونظيفة"   
and make them bold, italic and underline. 
d- Change the background color to be "green". 
e- Insert an image from your computer to the web page in the left side  
     and make its dimensions Width= 800 pixel and Height= 450 pixel 
e- Save the text file on desktop and name it "Computer". 
Open this file in any web browser. 

The answer 
<html>                                                                                                                                                                                                       

<head> 

<title> School </title> 

</head> 

<body  dir="rtl" bgcolor="green"> 

<B><I><u>  مدرسه السلام الأعداديه الثانويه   

<br> مدرستى جميلة ونظيفة ومتطورة   </B></I></u> 

<img src="school.jpg" height="450" width="800"align="left">. 

</body> 

</html> 

File->save  computer .html 

 
 


